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4 | Introduction

1 Introduction
In this chapter, you can find information about the intended use, the addressed tar-
get group, and information about safety and privacy related topics.

Please adhere to the ETAS Safety Advice (accessible via Help > Product Dis-
claimer in the ASCET Component Manager) and to the safety information given
in the user documentation.

ETAS GmbH cannot be made liable for damage which is caused by incorrect use
and not adhering to the safety information.

1.1 Intended Use
The ASCET tools support model-based software development. In model-based de-
velopment, you construct an executable specification -– the model -– of your sys-
tem and establish its properties through simulation and testing in early stages of
development. When a model behaves as required, it can be converted automati-
cally to production-quality code via ASCET.

The AUTOSAR to ASCET Converter allows you to convert your AUTOSAR models,
given as a collection of *.arxml files, into an ASCET model based on the AMD
V6.4.8 format. The model can be imported in an ASCET database or workspace.

1.2 Target Group
This user guide addresses qualified personnel working in the fields of automobile
control unit development and calibration. Specialized knowledge of ASCET and the
AUTOSAR concepts (especially of the AUTOSAR Software Component Template,
available at www.autosar.org) is required.

1.3 Classification of Safety Messages
Safety messages warn of dangers that can lead to personal injury or damage to
property:

DANGER
DANGER indicates a hazardous situation that, if not avoided, will result in death
or serious injury.

WARNING
WARNING indicates a hazardous situation that, if not avoided, could result in
death or serious injury.

CAUTION
CAUTION indicates a hazardous situation that, if not avoided, could result in mi-
nor or moderate injury.

ETAS ASCET V6.4 AUTOSAR to ASCET Converter | User Guide
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NOTICE
NOTICE indicates a situation that, if not avoided, could result in damage to prop-
erty.

1.4 Safety Information
Observe the following safety information when using the NVRAM capabilities of the
ASCET-RP or ASCET-SE targets, to avoid injury to yourself and others as well as
damage to property:

WARNING
Harm or property damage due to unpredictable behavior of vehicle or test
bench

Wrongly initialized NVRAM variables (NV variables) can lead to unpredictable
behavior of a vehicle or a test bench. This behavior can cause harm or property
damage.

ASCET projects that use the NVRAM possibilities of AUTOSAR expect a user-
defined initialization that checks whether all NV variables are valid for the current
project, both individually and in combination with other NV variables. If this is not
the case, all NV variables have to be initialized with their (reasonable) default val-
ues.

Due to the NVRAM saving concept, this is absolutely necessary when projects
are used in environments where any harm to people and equipment can hap-
pen when unsuitable initialization values are used (e.g. in-vehicle-use or at test
benches).

Adhere to the ETAS Safety Advice and the safety information given in the online
help and user guides. You can open the ETAS Safety Advice from the main ASCET
window with Help > Product Disclaimer. A PDF version is available on the instal-
lation medium: Documentation\ETAS Safety Advice.pdf

In addition, take all information on environmental conditions into consideration be-
fore setup and operation (see the documentation of your computer, hardware, etc.).

Further safety advice is given in the ASCET V6.4 safety manual available at ETAS
upon request.

1.5 Data Protection
If the product contains functions that process personal data, legal requirements of
data protection and data privacy laws shall be complied with by the customer. As
the data controller, the customer usually designs subsequent processing. There-
fore, he must check if the protective measures are sufficient.

1.6 Data and Information Security
To securely handle data in the context of this product, see the next sections about
data and storage locations as well as technical and organizational measures.

ETAS ASCET V6.4 AUTOSAR to ASCET Converter | User Guide
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1.6.1 Data and Storage Locations
The following sections give information about data and their respective storage lo-
cations for various use cases.

1.6.1.1 License Management
When using the ETAS License Manager in combination with user-based licenses
that are managed on the FNP license server within the customer’s network, the fol-
lowing data are stored for license management purposes:

Data

• Communication data: IP address

• User data: Windows user ID

Storage location

• FNP license server log files on the customer network

When using the ETAS License Manager in combination with host-based licenses
that are provided as FNE machine-based licenses, the following data are stored for
license management purposes:

Data

• Activation data: Activation ID

Used only for license activation, but not continuously during license usage

Storage location

• FNE trusted storage

C:\ProgramData\ETAS\FlexNet\fne\license\ts

1.6.1.2 Problem Report
When an error occurs, ASCET offers to send an error report to ETAS for trou-
bleshooting. ETAS uses the personal information to have a contact person in case
of system errors.

The problem report may contain the following personal data or data category:

Data

• Communication data: IP address

• User data: Windows user ID, user name

Storage location

• EtasLogFiles<index number>.zip in the ETAS-specific log files direc-
tory

Additionally to the problem information that is entered by the users themselves,
ASCET collects the available product-related log files in a ZIP archive to support
the bug fixing process at ETAS. The zip file is named according to the pattern
EtasLogFiles<index number>.zip. See also chapter 5 "Support Function for
Feedback to ETAS in Case of Errors" in the ASCET Getting Started manual.

All ETAS-related log files in the ETAS-specific log files directory and the zip
archives created by the Problem Report feature can be removed after closing all
ETAS applications if they are no longer needed.

ETAS ASCET V6.4 AUTOSAR to ASCET Converter | User Guide
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1.6.2 Technical and Organizational Measures
We recommend that your IT department takes appropriate technical and organiza-
tional measures, such as classic theft protection and access protection to hardware
and software.

1.6.2.1 Locations for Generated Files
Names and paths of files generated by ASCET may contain personal data,
if they refer to the current user’s personal directory or subdirectories (e.g.,
C:\Users\<UserId>\Documents\...).

If you do not want personal information to be included in the generated files, make
sure of the following:

– The workspace of the product points to a directory without personal refer-
ence.

– All settings in the product (accessed via the menu function Tools > Options
in the product) refer to directories and file names without personal reference.

– All project settings in the projects (accessed via the menu function File >
Properties in the ASCET project editor) refer to directories and file names
without personal reference.

– Windows environment variables (such as the temporary directory) refer to
directories without personal reference because these environment variables
are used by the product.

In this case, please also make sure that the users of this product have read and
write access to the newly set directories.

ETAS ASCET V6.4 AUTOSAR to ASCET Converter | User Guide
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2 About the AUTOSAR to ASCET Converter
The AUTOSAR to ASCET Converter allows you to convert your AUTOSAR models,
given as a collection of *.arxml files, into an ASCET model based on the AMD
V6.4.8 format. The model can be imported in an ASCET database or workspace.

The input for AUTOSAR to ASCET conversion is a set of *.arxml files.

The AUTOSAR to ASCET Converter supports several AUTOSAR versions (see
Tab. 2.1), but all files converted/imported at the same time must be of the same
AUTOSAR version.

– R4.0.2
– R4.0.3

– R4.2.2 – R4.3.0
– R4.3.1

Table 2.1: Supported AUTOSAR versions

2.1 Typical Workflow
The typical conversion/import workflow consists of the following steps:

A. A set of *.arxml files is sent to the AUTOSAR to ASCET Converter.

B. The AUTOSAR to ASCET Converter checks if all input files have the same
AUTOSAR version.

– Yes: Conversion/Import continues.
– No: Conversion/Import aborts with an error message.

C. The AUTOSAR to ASCET Converter collects information on the following
AUTOSAR items:

• Application-Software-Component types (cf. section 4.1)
– Required and Provided ports
– runnable entities
– OperationInvoke event
– ModeSwitch event
– Timing event

• AUTOSAR interfaces
– CalPrm/parameter interfaces (cf. section 4.6)
– sender-receiver interfaces (cf. section 4.2)
– mode-switch interfaces1 (cf. section 4.3)
– NVData interfaces1 (cf. section 4.5)
– client-server interfaces (cf. section 4.7)

• mode declaration groups (cf. section 4.4)

• record types (cf. section 4.8)

• array types (cf. section 4.9)

• compu methods2 (cf. sections 4.10 and 4.11 )

• primitive data types (cf. section 4.12)

• variation points (cf. section 4.13)

1 available since AUTOSAR R4.0.2
2 only IDENTICAL, LINEAR, RATFUNC and TEXTTABLE are considered
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• DataDefProps3 (cf. section 4.14)

D. The AUTOSAR to ASCET Converter uses the information gathered in step C
to generate the corresponding ASCET counterparts, i.e. *.amd files in the
AMD version V6.4.8. If desired (see section ""AUTOSAR Conversion" Node"
on page 23), an ASCET project is created for each AUTOSAR SWC.

The generated files are stored on the Windows file system, in a configurable
directory.

E. If a database or workspace is currently open in ASCET, and if the respective
conversion option is activated (see section ""AUTOSAR Conversion" Node"
on page 23), the generated *.amd files are imported into ASCET.

AUTOSAR name spaces are mapped to folder structures in the AS-
CET database or workspace. An AUTOSAR element with a path of
/BaseSystem/DataTypes/VoltBatt will be imported to the top-level
folder BaseSystems, subfolder DataTypes, component VoltBatt.

If desired, the entire package paths for interfaces and units can be imported,
too; see also section ""AUTOSAR Conversion" Node").

2.2 Terms and Abbreviations

AMD An XML-based data exchange format in ASCET.

ARXML An XML language used to describe AUTOSAR configura-
tions.

AUTOSAR AUTomotive Open System ARchitecture – a stan-
dardized software architecture targeted at automo-
tive applications, aimed at fostering the reuse of ap-
plication software over multiple vehicle platforms.
See also www.autosar.org.

ASCET ETAS development tool for ECU software

GUI Graphical User Interface

SWC AUTOSAR software component; the smallest non-
dividable software unit in AUTOSAR.

XML eXtensible Markup Language

3 only SW-CALIBRATION-ACCESS, SW-IMPL-POLICY, and
SW-ADDR-METHOD are considered
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3 Installation
The AUTOSAR to ASCET Converter installation is part of the ASCET base system;
it cannot be installed separately.

At least one of the add-ons ASCET-MD, ASCET-RP and ASCET-SE must be in-
stalled, too, before you can use the AUTOSAR to ASCET Converter. ASCET-SE is
required for AUTOSAR code generation in ASCET.

See the ASCET installation guide, ASCET V6.4 Installation Guide.pdf, for
details on ASCET installation.

Note

If you install only ASCET-SE or ASCET-RP, you can import AUTOSAR models
into ASCET, but you cannot edit the imported models.
It is therefore recommended that you install both ASCET-SE and ASCET-MD.

The AUTOSAR to ASCET Converter is installed in the <ASCET-Root>1\
tools\AutosarToAscetImporter directory. The executable to start the appli-
cation is called A2AImporter.exe.

3.1 Licensing
The ASCET product family uses the following licenses:

License name Functionality

ASCET-MD ASCET Modeling and Design (includes the AUTOSAR to
ASCET Converter)

ASCET-RP ASCET Rapid Prototyping

ASCET-SE ASCET Software Engineering

ASCET-DIFF ASCET Difference Viewer

ASCET-VIEW ASCET Model Viewer (part of the ASCET-DIFF software)

ASCET-SCM ASCET Software Configuration Management

Table 3.1: Licenses used by the ASCET product family

A valid license is required to use the software. You can obtain a license in one of
the following ways:

– from your tool coordinator

– via the self-service portal on the ETAS website at
www.etas.com/support/licensing

– via the ETAS License Manager

To activate the license, you must enter the Activation ID that you received from
ETAS during the ordering process.

1<ASCET-Root> is, e.g., C:\ETAS\ASCET6.4
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For more information about ETAS license management, see the ETAS License
Management FAQ or the ETAS License Manager help.

To open the ETAS License Manager help

The ETAS License Manager is available on your computer after the installation of
any ETAS software.

1. From the Windows Start menu, select E > ETAS > ETAS License Manager.

The ETAS License Manager opens.

2. Click in the ETAS License Manager window and press <F1>.

The ETAS License Manager help opens.

ETAS ASCET V6.4 AUTOSAR to ASCET Converter | User Guide
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4 AUTOSAR Features and their ASCET Counterparts
This section lists the AUTOSAR features that can be converted to ASCET features,
and their ASCET counterparts.

4.1 Software Components
AUTOSAR software components (AUTOSAR SWC) are converted to ASCET soft-
ware components (ASCET SWC).

4.1.1 Ports
AUTOSAR ports are converted to ASCET ports as follows.

– For each AUTOSAR P-PORT-PROTOTYPE, a provided port is created in the
ASCET SWC.

– For each AUTOSAR P-PORT-PROTOTYPE of type client-server interface, a
public diagram named <port_name>_<interface_name> is created.

• For each operation of the P-PORT-PROTOTYPE of type client-server in-
terface, a runnable with corresponding signature is created in the public
diagram.

– For each AUTOSAR R-PORT-PROTOTYPE, a required port is created in the
ASCET SWC.

4.1.2 Internal Behavior: Runnable Entities and Events
Each <SWC-INT-BEHAVIOR> section is checked if it belongs to the current
AUTOSAR SWC and if it provides runnable entities.

The UUID of the internal behavior is assigned to the Main diagram in the ASCET
SWC.

Note

Only one internal behavior per SWC is supported.

– For each runnable entity in the <SWC-INT-BEHAVIOR> section, a corre-
sponding runnable entity is created in the ASCET SWC.

Runnable entity attributes, such as MINIMUM-START-INTERVAL, UUID, and
CAN-BE-INVOKED-CONCURRENTLY, are transferred to ASCET.
CAN-BE-INVOKED-CONCURRENTLY and MINIMUM-START-INTERVAL are
available in the signature editor of the respective runnable.

The implementation of the ASCET runnable entity is set as follows:

Implementation
parameter

Value

Inlining set to Automatic, read-only

Use FPU activated

Memory Location derived from AUTOSAR parameter

SW-ADDR-METHOD-REF

Memory Segment Automatic

Symbol derived from AUTOSAR parameter SYMBOL in the
<RUNNABLE-ENTITY> declaration

ETAS ASCET V6.4 AUTOSAR to ASCET Converter | User Guide
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– For each operation-invoked event in <SWC-INT-BEHAVIOR>, a correspond-
ing OperationInvoked event is created in the ASCET SWC.

– For each timing event, a corresponding timing event specification is created
in the ASCET SWC.

– For each mode-switch event, a corresponding ModeSwitch event specifica-
tion is created in the ASCET SWC.

4.1.3 Internal Behavior: Interrunnable Variables
Scalar, array and record interrunnable variables in an AUTOSAR SWC are con-
verted to interrunnable variables in the ASCET SWC. The properties of the
AUTOSAR interrunnable variables (e.g., explicit/implicit, type, implementation) are
converted, too.

In AUTOSAR, interrunnable variables can have init values. If the init
values are specified as NUMERICAL-VALUE-SPECIFICATION or
ARRAY-VALUE-SPECIFICATION, they are converted to ASCET according to
the following rules.

– If the AUTOSAR interrunnable variable is associated to an application data
type, the representation of init values in numeric data is interpreted as model
values in ASCET.

If not, the init values are interpreted as implementation values in ASCET.

– For Boolean interrunnable variables, the init values (0/1, true/false,
TRUE/FALSE) are converted to the ASCET model representation
true/false.

– For an interrunnable variable of Enumeration type, values and symbolic la-
bels of the init values are converted to the ASCET model representation ac-
cording to the definitions in the CompuMethod.

– For scalar interrunnable variables, init values given in implementation rep-
resentation are converted to ASCET model representation by applying the
appropriate CompuMethod.

4.2 Sender-Receiver Interfaces
AUTOSAR sender-receiver interfaces are converted to ASCET SenderReceiver in-
terfaces.

Interface elements are converted to ASCET independent of the value of the
IS-QUEUED attribute.

A sender-receiver interface can contain only data elements (scalar, array, matrix,
record). The corresponding ASCET SenderReceiver interface also contains only
data elements.

Mode group parameters are contained in Mode-Switch interfaces; see next section.

4.3 Mode-Switch Interfaces
An AUTOSAR mode-switch interface (introduced in AUTOSAR R4.0.2) is mapped
to an ASCET SenderReceiver interface that contains only mode group parameters.
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4.4 Mode Declaration Gropus
An AUTOSAR mode declaration group is converted to an ASCET mode group.

The initial mode of the mode declaration group is used as first mode in the ASCET
mode group.

4.5 NV-Data Interfaces
AUTOSAR NV-data interfaces are converted to ASCET NVData interfaces.

4.6 Parameter Interfaces
AUTOSAR Parameter interfaces are converted to ASCET Calibration interfaces,
with all elements and implementation information.

4.7 Client-Server Interfaces
AUTOSAR client-server interfaces are converted to ASCET ClientServer interfaces.

Operation prototypes in AUTOSAR client-server interfaces are converted to public
methods (with arguments) in ASCET.

The errors defined in the <Possible-Errors> section of the AUTOSAR in-
terface are converted to an ASCET enumeration, which is named <name of
client-server interface>_AppError.

4.8 Record Types
AUTOSAR record types are converted to ASCET records, with all elements and im-
plementation information. The element order of the record types is preserved.

4.9 Array Types
One-dimensional AUTOSAR array types with fixed array size are converted to AS-
CETarrays without variant size.

The size of the ASCET array is derived from MAX-NUMBER-OF-ELEMENTS in the
AUTOSAR definition.

Note

Dynamic AUTOSAR arrays or arrays with more than one dimension are not sup-
ported in ASCET V6.4.

4.10 CompuMethods
In AUTOSAR, CompuMethods are organised in AR-packages. Depending on the
category of a CompuMethod, its ASCET counterpart is either a formula, which is
connected to ASCET projects, or an ASCET enumeration.

The following CompuMethod categories are converted to ASCET formulas:

CompuMethod category ASCET formula

IDENTICAL ident formula

LINEAR linear formula

RAT_FUNC

(if convertible to Moebius formula) Moebius formula
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CompuMethods of category TEXTTABLE in combination with an integer type are
converted to ASCET enumerations; see next section.

CompuMethods of other categories cannot be converted to an ASCET feature. A
log message is issued for each unsupported CompuMethod in the *.arxml input
files.

4.11 CompuMethods of Category TEXTTABLE
A CompuMethod of category TEXTTABLE in combination with an AUTOSAR integer
type is converted to an ASCET enumeration. The name of the ASCET enumeration
is derived from the <SHORT-NAME> of the AUTOSAR integer type.

Each COMPU-SCALE definition in the CompuMethod is converted to an enumerator
in the ASCET enumeration. The value in UPPER-LIMIT and LOWER-LIMIT be-
comes the enumerator value in ASCET, and the text given in COMPU-CONST be-
comes the enumerator label.

The following criteria must be met for a successful import:

– UPPER-LIMIT and LOWER-LIMIT in one COMPU-SCALE must be identical.

– Upper and lower limit must be integer values.

The limit values in consecutive COMPU-SCALEs do not have to be consecu-
tive. ASCET V6.4 allows non-consecutive enumerator values.

– The information given in COMPU-CONST must be valid.

If no valid enumerator label can be retrieved, a warning is issued. Import
is continued, with _<lower limit as string> instead of the invalid
COMPU-CONST information.

4.12 Primitive Types
AUTOSAR R4.0.2 introduced a type concept that can describe elements from ap-
plication and implementation point of views. With that, the AUTOSAR to ASCET
Converter is able to retrieve the appropriate model data type as well as, partially,
a suitable implementation data type and implementation attributes from *.arxml
files.

– Logic

If an AUTOSAR element is associated with an application type of
category BOOLEAN, or the element’s underlying platform type is
/AUTOSAR_PlatformTypes/ImplementationDataTypes/ boolean,
the ASCET model data type is logic with implementation data type bool.

– Enumeration

If an AUTOSAR element is associated with an integer type, and this type is
associated with a CompuMethod of category TEXTTABLE, the element will
be converted to an ASCET enumeration.

– Discrete

If an AUTOSAR element is associated with an integer type, and if this integer
type is associated with a CompuMethod of category IDENTICAL, or does not
have any CompuMethod, the resulting ASCET model data type is sdisc or
udisc.

The AUTOSAR to ASCET Converter uses the associated constraint rules
and the defined Lower-Limit to select sdisc (Lower-Limit < 0) or
udisc (Lower-Limit ≥ 0).
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Min/Max values in the ASCET implementation are derived from the associ-
ated constraint rules, if available.

– Continuous

a. If an AUTOSAR element is associated with an integer type, and if this
integer type is associated with a CompuMethod of category LINEAR or
RATFUNC1, the resulting ASCET model data type is continuous.

Min/Max values in the ASCET implementation are derived from the asso-
ciated constraint rules, if available.

The AUTOSAR CompuMethod is converted to an appropriate ASCET for-
mula; see also section 4.10 on page 14.

b. If an AUTOSAR element is associated with a real type, the resulting AS-
CET model data type is continuous.

Min/Max values in the ASCET implementation are derived from associ-
ated constraint rules, if available.

The CompuMethod is converted to an ASCET formula of type Identity.

4.13 System Constants and Variation Points
AUTOSAR R4.0.2 introduced some concepts for variant management. These are
supported since ASCET 6.4.2.

However, the variation points are not part of the model, but inferred from the spec-
ified behavior. For this reason, variation points and also variation point proxies are
not imported, but also do not lead to an error if they occur in the ARXML.

Variation points and variation point proxies refer to system constants, and these are
imported as exported elements in the project, if one is created (see also section
5.1.2.1).

4.14 DataDefProps
AUTOSAR uses the <SW-DATA-DEF-PROPS> section to attach various properties
and associations to the definitions of data types and prototypes. The AUTOSAR to
ASCET Converter converts the following properties in the SW-DATA-DEF-PROPS:

– SW-CALIBRATION-ACCESS

This AUTOSAR property is converted to a suitable setting of Write and Read
in the "Calibration Access" area of the ASCET element’s properties editor.

AUTOSAR value ASCET settings

READ-ONLY Write deactivated, Read activated

READ-WRITE Write activated, Read activated

NOT-ACCESSIBLE Write deactivated, Read deactivated

If SW-CALIBRATION-ACCESS is not set in AUTOSAR, the AUTOSAR to AS-
CET Converter uses the following defaults:

– elements of CalPrm / Parameter interfaces: Write activated, Read acti-
vated

– other elements: Write deactivated, Read activated

– SW-IMPL-POLICY

All possible values (STANDARD, CONST, FIXED, MEASUREMENT_POINT,
QUEUED) of this AUTOSAR property are copied one-to one to the "Policy"

1 must be convertible to a Moebius formula
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combo box in the "AUTOSAR" tab of the ASCET element’s implementation
editor.

If SW-IMPL-POLICY is not set in AUTOSAR, the AUTOSAR to ASCET Con-
verter uses STANDARD as default.

– SW-ADDR-METHOD

This AUTOSAR property is copied one-to one to the "Memory Location of
Instance" combo box of the ASCET element’s properties editor.

If SW-ADDR-METHOD is not set in AUTOSAR, the AUTOSAR to ASCET Con-
verter uses Default.
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5 AUTOSAR to ASCET Converter: User Interface
If you have some *.arxml files containing an AUTOSAR model, you can use the
AUTOSAR to ASCET Converter to convert them to the ASCET AMD format. If de-
sired, you can import the converted files into ASCET in the same step.

This chapter describes the graphical user interface of the AUTOSAR to ASCET
Converter, chapter 6 on page 29 describes using the AUTOSAR to ASCET Con-
verter via command-line interface.

To open the AUTOSAR to ASCET Converter

1. Start ASCET.

2. Open or create an empty ASCET database or workspace.

3. In the component manager, select Tools > AUTOSAR to ASCET Con-
verter.

The "AUTOSAR to ASCET Transfer" dialog window, shown in Fig. 5.1 on
page 19, opens.

As an alternative, you can open the Windows Explorer, navigate to the
<ASCET-Root>\tools\AutosarToAscetImporter directory, and double-click
the A2AImporter.exe file to open the AUTOSAR to ASCET Converter.

To activate automatic import in ASCET

1. Open the AUTOSAR to ASCET Converter (cf. page 18).

2. In the "AUTOSAR to ASCET Transfer" dialog window, select Window >
Preferences.

3. In the "Preferences" window, go to the "Conversion Options" node.

4. Activate the Transfer results to the database/workspace currently
opened in ASCET option.

5. Click OK to close the "Preferences" window.

With that setting, the next time you start a conversion while ASCET is running, the
converted files are directly imported into ASCET.

5.1 Description of the Graphical User Interface
Fig. 5.1 shows the "AUTOSAR to ASCET Transfer" window, i.e. the graphical user
interface of the AUTOSAR to ASCET Converter.

5.1.1 Main Window
The main window of the AUTOSAR to ASCET Converter is the "AUTOSAR to AS-
CET Transfer" window.
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Figure 5.1: Main Window of AUTOSAR to ASCET Converter
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5.1.1.1 Menus
The "AUTOSAR to ASCET Transfer" window contains the following menus.

– File

• Add ARXML File (<Ctrl> + <o>)

Opens a file selection dialog window where you can select the
*.arxml files you want to import.

• Remove ARXML File (<Delete>)

Removes a selected file from the list area of the "AUTOSAR to ASCET
Transfer" tab.

• Start Conversion (<Ctrl> + <r>)

Starts the conversion/import.

• Restart

Closes and re-opens AUTOSAR to ASCET Converter.

• Exit (<Ctrl> + <x>)

Closes the AUTOSAR to ASCET Converter.

• Convert Line Delimiters to

Converts line delimiters in the ARXML files to the selected format
(Windows or Unix).

• Open File

Opens a selected file in an appropriate editor or viewer.

– Window

• Preferences (<Ctrl> + <Alt> + <o>)

Opens the "Preferences" dialog window.

– Help

• About AUTOSAR to ASCET Converter

Opens the "About AUTOSAR to ASCET Converter" window with informa-
tion on the installation.

• User Manual (<F1>)

Opens this User Guide in an appropriate reader.

• Show Active Keybindings (<Ctrl> + <Shift> + <l>)

Opens a window with keyboard shortcuts for AUTOSAR to ASCET Con-
verter.

• Cheat Sheets

Opens the "Cheat Sheet Selection" window.

5.1.1.2 "AUTOSAR to ASCET Transfer" Tab
The "AUTOSAR to ASCET Transfer" tab contains the following elements.

– "AUTOSAR Model" area

• list area

Lists the *.arxml files selected for conversion/import.

The context menu in the list area contains the options Add, Remove,
and View. The latter opens the selected *.arxml file in a text editor.
See also section ""Miscellaneous" Node".
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• Add button

The same as Add ARXML File in the File menu (cf. page 20).

• Remove button

The same as Remove ARXML File in the File menu.

• Remove All button

Removes all *.arxml files.

• Load AUTOSAR button

Loads the *.arxml files into the AUTOSAR to ASCET Converter. The
AUTOSAR SWC found in the *.arxml files are shown in the "AUTOSAR
model components" area.

Issues detected during load are shown in the "Console" tab (see also
section ""Console" Tab").

– "AUTOSAR model components" area

• table area

When Load AUTOSAR was clicked, the table lists all AUTOSAR SWC
found in the *.arxml files.

You can select/deselect an SWC by activating/deactivating the option in
the respective row.

• Run All button

The same as Start Conversion in the File menu.

• Select All / Unselect All button

Selects/deselects all AUTOSAR SWC listed in the table. When you click
Select All, the button becomes Deselect All, and vice versa.

• Run Selected button

Converts the AUTOSAR SWC selected in the table.

Note

If you click Run Selected when no SWC is selected in the table, an error
is issued.
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– "Output" area

• input field

Shows the folder for the converted files. The folder can be entered di-
rectly, or selected via the adjacent button.

• button

Opens the "Output Folder Selection" dialog window where you can select
a folder for the converted files.

5.1.1.3 "Console" Tab

This tab displays the messages issued by the conversion procedure1. Error and
warning messages are numbered, information messages are unnumbered.

5.1.1.4 "Error Log" Tab
This tab shows all eclipse-internal errors and problems.

5.1.2 "Preferences" Window
Fig. 5.2 on page 22 shows the "Preferences" window, where you can set up the be-
havior of the AUTOSAR to ASCET Converter.

Figure 5.2: "Preferences" Window of the AUTOSAR to ASCET Converter

This window contains the following elements:

– At the top left, a filter for node names.

– At the left, a tree view with the option groups as nodes.

– At the right, the display field for the options of the selected node.

– Restore Defaults button

Restores the default settings of the selected node.

– Apply button

Accepts your changes without closing the window.

– OK button
1 Messages issued by the import procedure are displayed in the ASCET moni-

tor window.
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– Cancel button

The nodes specific to the AUTOSAR to ASCET Converter are described in the fol-
lowing sections.

5.1.2.1 "AUTOSAR Conversion" Node
This node contains the following options:

– Transfer results to the database or workspace currently opened in AS-
CET

Default: activated

This option must be activated if you want to import the converted files imme-
diately into ASCET.

If the option is deactivated, or if no database or workspace is open in AS-
CET, or if no ASCET is running, the converted files are only written to the
output directory.

NOTICE
Data loss due to overwriting

If Transfer results * is activated, the AUTOSAR to ASCET Converter im-
ports the generated *.amd files into the currently open ASCET database
or workspace.

When an item is imported that already exists in the target database or
workspace, the existing item is overwritten without notification.

To avoid the loss of your models, do the following:

– Before starting the conversion/import, make sure that the correct AS-
CET instance is running and the correct database or workspace is
open.

– Import name spaces (interfaces, compu methods, units)

Default: activated

AUTOSAR name spaces are mapped to folder structures in the ASCET
database or workspace (see section 2.1, step D). If the Import name
spaces * option is activated, the entire package path for interfaces and units
is imported, too.

For interfaces, the information is written to the "AUTOSAR Package Name"
field in the "Settings" tab of the implementation editor (see also Fig. 5.3 on
page 24).

For units, the information is written to the "Comment" field of the respective
formula editor (see also Fig. 5.4 on page 24).

– Create an ASCET project for each application software component

Default: activated

In AUTOSAR, COMPU-METHODs are organized in AR-Packages. The AS-
CET counterparts of COMPU-METHODs are formulas, which are connected to
ASCET projects.

If the Create an ASCET project * option is activated, an ASCET project is
created for each imported SWC. The project is named <swc_name>P; it is
stored in the same ASCET folder as the SWC.
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Figure 5.3: "Settings" tab of the implementation editor

Figure 5.4: Formula editor with unit information
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Each SWC’s COMPU-METHODs of categories2 IDENTICAL, LINEAR and
RAT_FUNC (if convertible to a Moebius formula) are converted to the respec-
tive formulas in the project.

Note

If Create an ASCET project * is deactivated, and thus no projects are cre-
ated, import of COMPU-METHODs as ASCET formulas is impossible.

– Create software components as ESDL components

Default: deactivated

Since ASCET version 6.4.2, software components can be specified using ei-
ther block diagrams or ESDL. By default, the AUTOSAR to ASCET Converter
creates block diagram software components. If this option is enabled, ESDL
software components are created.

– Platform Implementation Types

The implementation data types in the ARXML input often refer to platform im-
plementation types, that are not defined inside the ARXML. To import such
files, the importer recognizes the types sint8, uint8, sint16, uint16,
sint32, uint32, float32, float64, sint8_least, uint8_least,
sint16_least, uint16_least, sint32_least, uint32_least and
boolean in the specified package name as available implementation types
and does not issue an error due to a missing type.

Note

The current default value of Platform Implementation Types is suitable
for AUTOSAR versions R4.1 and higher.

AUTOSAR R4.0 needs a value of /AUTOSAR_PlatformTypes/
ImplementationDataTypes.

5.1.2.2 "Error Handling" Node
This node contains the following options:

– "Consider As Error" input field

This field can be used to promote a warning to an error. Enter the number of
the warning, without square brackets.

– "Consider As Warning" input field

This field can be used to downgrade an error to a warning. Enter the number
of the error, without square brackets.

– Prompt if no ASCET instance was found

Default: activated

If activated, a warning opens if the option Transfer results * (see page 23) in
the "Conversion Options" node is activated, but no ASCET is running when
conversion and import are started.

2 COMPU-METHODs of category TEXTTABLE are converted to enumerations,
see section 4.11 on page 15. COMPU-METHODs of other categories than men-
tioned here are not supported; log entries are created for them.
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– Prompt if no database or workspace is open in ASCET Default: activated

If activated, a warning opens if the option Transfer results * (see page 23) in
the "Conversion Options" node is activated, but no database or workspace is
currently open in ASCET when conversion and import are started.

– Prompt if transfer is initiated

Default: activated

If activated, a warning opens if the option Transfer results * (see page 23) in
the "Conversion Options" node is activated and import into ASCET starts.

5.1.2.3 "Miscellaneous" Node
This node contains the following options:

– "Editor Path" input field and Browse button

This field can be used to specify a text editor that will open when you select
View from the context menu of an *.arxml file in the "AUTOSAR to ASCET
Transfer" tab (cf. section "AUTOSAR to ASCET Transfer" Tab on page 20).

5.1.3 Message Windows
Depending on the settings in the "AUTOSAR Conversion" (cf. page 23) and "Error
Handling" (cf. page 25) nodes of the "Preferences" window, three message win-
dows can open. These message windows are structured as shown in Fig. 5.5 on
page 26.

Figure 5.5: Message windows of the AUTOSAR to ASCET Converter

Read the message text carefully before you respond.

– Activate the Don’t show this message again option and click OK if you
want to suppress the respective warning and continue the operation accord-
ing to the message text in all following cases.

Suppressed warnings can be reactivated with the options in the "Error Han-
dling" node (cf. page 25).

– Click OK and deactivate Don’t show this message again to continue the
operation according to the message text, without suppressing the respective
warning.

– Click Cancel to abort the operation.

If you click Cancel, the Don’t show this message again option has no ef-
fect, the warning appears the next time the respective state is detected.
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5.2 Converting and Importing AUTOSAR Models

To convert and import ARXML files

1. In the "AUTOSAR to ASCET Transfer" dialog window, do one of the follow-
ing.

• Select File > Add ARXML File.

• Click the Add button.

• Press <Ctrl> + <o>.

A file selection window opens.

2. In the file selection window, navigate to the folder that contains your AU-
TOSAR model, and select one or more *.arxml files.

3. Click Open to add the file(s) to the list in the transfer window.

Note

The AUTOSAR to ASCET Converter requires input files with identical
AUTOSAR versions.
If you select *.arxml files with different AUTOSAR versions, conver-
sion/import is aborted and an error message is issued.

You can also drag files or folders from the Windows Explorer and drop them
on the list area of the "AUTOSAR to ASCET Transfer" tab.

4. Use the Add, Remove, or Remove All buttons to refine your selections.

5. In the "Output" area, do one of the following to
specify a folder for the resulting *.amd files.

Note

You must select an empty folder. A non-empty folder causes an error.

• In the input field, enter an output folder.

If the folder you entered does not exist, it is created when conversion/im-
port is started.

• Use the button to select an output folder.

• In the input field, press <Ctrl> + <Space> to open a list of suggested
output folders.

You can select one of the suggested folders or <create new temp
folder>.

6. If you want to import the converted files into ASCET, make sure that auto-
matic import is activated (see also page 18).
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7. If desired, click Load AUTOSAR to load the *.arxml
files into the AUTOSAR to ASCET Converter.

Note

Load AUTOSAR causes an error if no path is specified in the "Output"
area.

The SWC found in the files are listed in the "AUTOSAR model components"
area. Issues detected during load are shown in the "Console" tab (cf. section
5.1.1.3 on page 22).

8. If desired, select the AUTOSAR SWC you want to convert/import.

You can use the Run Selected button only if you selected at least one
AUTOSAR SWC.

9. Do one of the following to start conversion/import:

• Click Run All to convert/import all AUTOSAR SWC in
the selected files.

Note

Run All works even without preceding Load AUTOSAR .

• Click Run Selected to convert/import the selected
AUTOSAR SWC.

Log messages are shown in the "Console" tab of the AUTOSAR to ASCET
Converter. If the conversion succeeds, and if the Transfer results * op-
tion is activated (see page 23), the AUTOSAR models are imported into the
database or workspace currently open in ASCET.
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6 AUTOSAR to ASCET Converter: Command-Line Inter-
face
This chapter describes the command-line interface of the AUTOSAR to ASCET
Converter. Chapter 5 "AUTOSAR to ASCET Converter: User Interface" describes
how to use the AUTOSAR to ASCET Converter via its graphical user interface.

It is possible to use the AUTOSAR to ASCET Converter directly from the command
line, without GUI. The command-line syntax looks as follows:

A2AImporter.exe -nosplash -consoleLog
--launcher.suppressErrors -application
com.etas.ascet.importer.a2a.headless.appl
-platformimplementationtypes pck
(-projects|-namespaces|-transfer|-inv t)* -outdir path
(-file f)+

Listing 6.1: Command Line Syntax

The first part is required to start the application itself:

A2AImporter.exe -nosplash -consoleLog
--launcher.suppressErrors -application
com.etas.ascet.importer.a2a.headless.appl

-nosplash
Eclipse-specific option to suppress the splash window.

-consoleLog
Requires eclipse to redirect all outputs to stdout stderr stream to a logfile in
the workspace.

--launcher.suppressErrors
Suppresses the eclipse launcher window, which would appear if the command
line could not be processed correctly.

-application <appl name>
Starts the main plug-in of the application.

com.etas.ascet.importer.a2a.headless.appl is the <appl name>
of the AUTOSAR to ASCET Converter for the command-line use case.

The second part passes the configuration parameters for the conversion process to
the AUTOSAR to ASCET Converter:

-platformimplementationtypes pck
(-projects|-namespaces|-transfer|-inv t)* -outdir path
(-file f)* -wsport p -ESDLaswc -packname -swc f

The following configuration parameters can be specified:

-file f
This option is used to define the input file.

f must be an absolute path to an *.arxml file.

-file f can be repeated several times in the command line.
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-platformimplementationtypes pck
This option is used to pass the AUTOSAR package for platform implementa-
tion types to the AUTOSAR to ASCET Converter.

pck must be the package used by the AUTOSAR file(s) you want to import,
e.g., /AUTOSAR_Platform/ImplementationDataTypes.

Note

-platformimplementationtypes pck is mandatory. If you omit this parame-
ter, the conversion aborts.

-outdir path
This options specifies the output folder path, where the generated AMD files
will be located.

path can be an absolute or relative path.

The output folder must be empty to avoid mixing AMD files of different origins.

-projects
This option requests the AUTOSAR to ASCET Converter to create a project
for each AUTOSAR SWC.

-projects is required if you want to transfer AUTOSAR CompuMethods to AS-
CET formulas.

-namespaces
If this option is used, the entire package path for interfaces and units is con-
verted to ASCET.

For interfaces, the information is written to the "AUTOSAR Package Name"
field in the "Settings" tab of the ASCET implementation editor (see also
Fig. 5.3 on page 24).

For units, the information is written to the "Comment" field of the respective
formula editor (see also Fig. 5.4 on page 24).

-transfer
This option starts the import of the converted AMD files into the current AS-
CET database or workspace.

-transfer works only if a database or workspace is currently open in ASCET.

Note

Data loss due to overwriting

When an item is imported that already exists in the target ASCET database
or workspace, the existing item is overwritten without notification.

To avoid the loss of your models, do the following:

– Before calling AUTOSAR to ASCET Converter, make sure that
the correct ASCET instance is running and the correct database or
workspace is open.

If you are using the command line interface, it is often better not to use the
-transfer option, but generate only a converted ASCET model and import the
model from within ASCET.
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-inv t
You can write all options in a separate text file and then use the -inv option to
pass the text file to the AUTOSAR to ASCET Converter as a command file.

t must be the absolute path to the text file.

-inv t can be repeated several times in the command line to specify several
command files.

-wsport p
This option specifies the web service port p required to transfer the model to a
particular ASCET instance.

Note

Only relevant if ASCET is running in multi-instance mode.

See also section "Running Multiple ASCET Instances from One Installation" in
the ASCET Installation Guide.

-ESDLaswc
If this option is specified, the created software components will use the ESDL
specification. If it is omitted, they will use block diagrams.

-packname
Specifies the package name for data types.

-swc f
Specifies the short name of the SWC from an input file.

f must be the absolute path to the file.

-swc f can be repeated several times in the command line to specify several
files.

A2AImporter.exe
-nosplash -consoleLog --launcher.suppressErrors
-application com.etas.ascet.importer.a2a.headless.appl
-platformimplementationtypes

/AUTOSAR_Platform/ImplementationDataTypes
-outdir D:\temp\headless
-projects
-namespaces
-transfer
-file C:\Working\ARImport\AR\SWComponent.arxml
-file C:\Working\ARImport\AR\autosar_types.arxml
-file C:\Working\ARImport\AR\SWComponent_interfaces.arxml
-file C:\Working\ARImport\AR\SWComponent_types.arxml

Listing 6.2: Command-line syntax (example)
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7 Contact Information

Technical Support

For details of your local sales office as well as your local
technical support team and product hotlines, take a look
at the ETAS website:

www.etas.com/en/hotlines.php

ETAS offers trainings for its products:

www.etas.com/academy

ETAS Headquarters

ETAS GmbH

Borsigstraße 24 Phone: +49 711 3423-0

70469 Stuttgart Fax: +49 711 3423-2106

Germany Internet: www.etas.com
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